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TO PERSONS WHO PURCHASE OR USE THIS PRODUCT:

 

Carefully read all the terms and conditions of this agreement before using this software package.  Using this software package indicates your 
acceptance of the terms and conditions of this license agreement.

Mark of the Unicorn, Inc. (“MOTU”) owns both this program and its documentation.  Both the program and the documentation are protected under 
applicable copyright laws.  Your right to use the program and the documentation are limited to the terms and conditions described herein.

 

License

 

YOU MAY: (a) use the enclosed program on a single computer; (b) physically transfer the program from one computer to another provided that 
the program is used on only one computer at a time and that you remove any copies of the program from the computer from which the program 
is being transferred; (c) make copies of the program solely for backup purposes.  You must reproduce and include the copyright notice on a label 
on any backup copy.

YOU MAY NOT: (a) distribute copies of the program or the documentation to others; (b) rent, lease or grant sublicenses or other rights to the 
program; (c) provide use of the program in a computer service business, network, time-sharing, multiple CPU or multiple user arrangement 
without the prior written consent of MOTU; (d) translate or otherwise alter the program or related documentation without the prior written consent 
of  MOTU.

 

Term

 

Your license to use the program and documentation will automatically terminate if you fail to comply with the terms of this Agreement.  If this license 
is terminated you agree to destroy all copies of the program and documentation.

 

Limited Warranty

 

MOTU warrants to the original licensee that the disk(s) on which the program is recorded be free from defects in materials and workmanship 
under normal use for a period of ninety (90) days from the date of purchase as evidenced by a copy of your receipt.  If failure of the disk has 
resulted from accident, abuse or misapplication of the product, then MOTU shall have no responsibility to replace the disk(s) under this Limited 
Warranty.

THIS LIMITED WARRANTY AND RIGHT OF REPLACEMENT IS IN LIEU OF, AND YOU HEREBY WAIVE, ANY AND ALL OTHER 
WARRANTIES, BOTH EXPRESS AND IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE.  THE LIABILITY OF MOTU PURSUANT TO THIS LIMITED WARRANTY SHALL BE LIMITED 
TO THE REPLACEMENT OF THE DEFECTIVE DISK(S), AND IN NO EVENT SHALL MOTU BE LIABLE FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO LOSS OF USE, LOSS OF PROFITS, LOSS OF DATA OR DATA BEING 
RENDERED INACCURATE, OR LOSSES SUSTAINED BY THIRD PARTIES EVEN IF MOTU HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS WHICH MAY VARY FROM STATE TO STATE.  SOME 
STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
LIMITATION MAY NOT APPLY TO YOU.

 

Update Policy

 

In order to be eligible to obtain updates of the program, you must complete and return the attached Mark of the Unicorn Purchaser Registration 
Card to MOTU.

 

General

 

This License Agreement shall be governed by the laws of the Commonwealth of Massachusetts and shall innure to the benefit of MOTU, its 
successors, administrators, heirs and assigns.

 

Copyright Notice

 

Copyright © 1996, 1995, 1994, 1993, 1992 Mark of the Unicorn, Inc. and its licensors. All rights reserved.  No part of this publication may be 
reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any human or computer language, in any form or by any 
means whatsoever, without express written permission of Mark of the Unicorn, Inc., 1280 Massachusetts Avenue, Cambridge, MA, 02138, U.S.A.

The Macintosh operating system portions are copyrighted programs of Apple Computer, Inc., licensed to Mark of the Unicorn, Inc., to distribute 
for use only in combination with Mosaic.  Apple Software shall not be copied onto another diskette (except for archive purposes) or into memory 
unless as part of the execution of Mosaic.  When Mosaic has completed execution, Apple Software shall not be used by any other program.

Composer’s Mosaic, Performer, Unisyn, Professional Composer, MIDI Time Piece, MIDI Time Piece II, MIDI Express, and Mark of the Unicorn 
are trademarks of Mark of the Unicorn, Inc.

PostScript, Adobe Type Manager, and Sonata are trademarks of Adobe Systems, Inc., 1585 Charleston Rd., P.O. Box 7900, Mountain View, CA  
94039-7900.

Macintosh® is a trademark licensed to Apple Computer, Inc.  Apple ®, The Finder , MultiFinder, and PatchBay are trademarks of Apple Computer, 
Inc.

Mark of the Unicorn License 
Agreement and Limited 

Warranty
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1

 

Welcome! 

 

Thank you for your interest in this public beta 
release of Mark of the Unicorn’s Composer’s 
Mosaic version 1.44b7.

We hope you enjoy using it.

 

FOR NEW MOSAIC USERS

 

If you are altogether new to Mosaic, this document 
helps you install Mosaic and then takes you on a 
brief guided tour. You may find it helpful to print a 
hard copy of this document because the graphics 
will be easier to read.

 

☛

 

Before you begin, you need to be aware that 
Mosaic requires Adobe’s Sonata music font, which 
Mark of the Unicorn is not licensed to distribute on 
line. For information about obtaining Sonata, 
please contact Adobe at (800) 642-3623. If you are 
calling from outside the United States, dial (408) 
986-6555.

 

FOR EXISTING MOSAIC USERS

 

If you are are already a registered Mosaic user, you 
will be pleased to know that this 1.44b7 beta 
version is being distributed publicly with no copy 
protection. This version has the following 
enhancements:

 

■

 

Mosaic is now accelerated for Power Macintosh.

 

■

 

Version 1.44b7 has many bug fixes and other 
enhancements.

 

☛

 

Mosaic 1.44b7 requires a 68020-based 
Macintosh or faster. It will no longer run on 68000-
based machines such as the Macintosh Plus.

This version of Mosaic uses the same fonts and 
system extensions as Mosaic 1.41 and 1.43, so if 
you already have these versions of Mosaic installed 
on your Macintosh, you need not do a full install 
from the 1.44b7 installer disks. Instead, you can 
simply install the Mosaic application. This version 
does, however, include the latest shipping version 
of FreeMIDI (1.2.4) will up-to-date MIDI device 
support. So you may want to install FreeMIDI from 
these disks, if you use Mosaic’s MIDI features.

Finally, existing Mosaic users don’t really need to 
review the rest of this guide, which has an 
installation guide and tutorial that are almost 
identical to your Mosaic 

 

Getting Started

 

 manual.

 

FOR ALL USERS

 

Mosaic Version 1.44b7 beta is a pre-release version 
of the program. Please take this into consideration 
when you use the program, and take extra 
precautions in saving and backing up any 
important work you do with the program.

 

!Mosaic Getting Started Book  Page 4  Thursday, May 9, 1996  6:05 PM



 

CHAPTER

 

5

 

2

 

Mosaic 1.44b7 System 
Requirements

 

This chapter provides important requirements and 
recommendations for the following components in 
your Macintosh computer system:

 

■

 

Type of Macintosh

 

■

 

RAM (memory)

 

■

 

Printer

 

■

 

System software

 

■

 

Adobe Type Manager™ (ATM)

 

■

 

LaserWriter Driver 8.1.1 (for EPS exporting)

 

■

 

FreeMIDI extension (required for MIDI 
recording and playback)

 

COMPUTER REQUIREMENTS & 
RECOMMENDATIONS

 

The minimum Macintosh needed to install and run 
Mosaic is a 68020-based Macintosh with a hard 
disk and a minimum of 4 megabytes (MB) of 

 

random access memory

 

 (RAM). A 68030, 68040, or 
PowerPC-based Macintosh is highly 
recommended. Mosaic 1.44b7 is acclerated for 
Power Macintosh.

 

RAM recommendations

 

For large scores, you may need a minimum of 5 
megabytes, depending on the size of your system 
software and the amount of additional startup 
software or other applications you run at the same 
time as Mosaic.

The minimum required amount of RAM to run 
Mosaic in System 7 is 4 MB. These 4 megabytes can 
consist of actual memory (RAM) or virtual 
memory (although virtual memory is not 
recommended if you will be using Mosaic’s MIDI 
playback and recording features), a process which 

uses space on the hard disk to emulate RAM. Refer 
to your System 7 documentation for information 
about virtual memory. Mosaic also supports the 
use of 32-bit memory mode.

To check how much RAM your Macintosh has, 
choose 

 

About this Macintosh

 

 (or 

 

About the Finder

 

 if 
you are running System 6) from the Apple menu 
and look for the Total Memory indication.

When you run Mosaic, the Memory Monitor 
displays the amount of free memory (RAM) 
available to Mosaic. Try to keep at least 100K free. 
To increase this amount in MultiFinder or System 
7, quit Mosaic, select the Mosaic program icon, and 
choose Get Info from the File menu. Increase the 
application memory size in the Get Info window.

 

A large screen monitor is recommended

 

Mosaic supports large screen monitors such as the 
Apple full-page and two-page displays. These large 
monitors are not required, but they are highly 
recommended for Mosaic. They provide many 
benefits, such as the ability to:

 

■

 

See the entire score page

 

■

 

Zoom in to enlarge the music while still 
observing a large portion of it in the display

 

■

 

Observe the contents of several windows simul-
taneously

 

Printer compatibility

 

Mosaic is compatible with the following printers:

 

■

 

The Apple ImageWriter, ImageWriter II, and 
ImageWriter LQ

 

■

 

Apple StyleWriter
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■

 

Apple LaserWriter (all models)

 

■

 

Most third-party PostScript-compatible laser 
printers

 

■

 

Most third party QuickDraw printers such as the 
Hewlett Packard DeskWriter™

 

■

 

Postscript-compatible phototypesetting 
machines such as the Linotronic™

 

System software requirements

 

Your Macintosh computer will not run without the 
System and Finder files, which are located in the 
System Folder. When turned on, the Macintosh 
looks for the System Folder on the first disk you 
insert (or on the hard disk). System software is 
included with the purchase of every Macintosh.

Macintosh System software is periodically updated 
by Apple. For Mosaic to run successfully, use the 
most recent update of the System software, which 
you can obtain from your Apple dealer.

The earliest System that we recommend for use 
with Mosaic is System release 6.0.5, which consists 
of Finder 6.1.5 and System 6.0.5. (Mosaic is 
MultiFinder-compatible.) To obtain the version 
number of the System and Finder files, choose 

 

About this Macintosh

 

 (or 

 

About the Finder

 

 if you are 
running System 6) from the Apple menu just after 
you switch on the computer.

 

The Adobe Type Manager™ is required

 

Mosaic also requires the Adobe Type Manager 
(ATM). ATM is a font utility developed by Adobe 
Systems, Inc. that enhances the appearance of your 
music on the screen. It also improves the quality of 
printed output on non-postscript printers, such as:

 

■

 

The Apple StyleWriter

 

■

 

The Apple LaserWriter IISC

 

■

 

The Apple ImageWriter LQ

 

■

 

Third-party (non-Postscript) laser printers

For information about obtaining ATM, contact 
Adobe at (800) 642-3623. If you are calling from 
outside the United States, dial (408) 986-6555.

 

LaserWriter 8.1.1 (or higher) is required for EPS 
export

 

There are two ways to export music from Mosaic 
into other desktop publishing programs:

1. Copying and pasting

2. Exporting as encapsulated PostScript™ (EPS)

Both methods maintain highest-quality printed 
output. The copying and pasting method has no 
special requirements. The EPS export method 
requires LaserWriter 8.1.1 (or higher), which is 
printer driver software provided by Apple 
Computer for the LaserWriter series of printers. 
Contact your Apple Dealer for information about 
obtaining the LaserWriter software.

 

FreeMIDI is required for MIDI playback and 
recording

 

FreeMIDI is a System extension developed by Mark 
of the Unicorn. It allows Mosaic to record and play 
back music on a MIDI keyboard or sound module. 
FreeMIDI also provides you with:

 

■

 

An intuitive environment in which to interact 
with your MIDI setup

 

■

 

Unified MIDI system integration with other 
MIDI programs, such as Mark of the Unicorn’s 
Performer sequencing software and Unisyn 
universal editor/librarian software

The section following the installation guide tells 
you everything you need to know about preparing 
your FreeMIDI studio configuration and getting 
Mosaic ready for MIDI playback and recording. To 
obtain FreeMIDI for this public beta release of 
Mosaic 1.44b7, download it from our web site 
(fttp://www.motu.com) or call (617) 576-2760 for 
a disk.
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Installation Guide

 

This chapter provides step-by-step instructions for 
installing Mosaic. If you haven’t already done so, 
review the system requirements in the last chapter 
to avoid trouble during installation and setup.

If you plan to record or play back your Mosaic 
scores via a MIDI keyboard or sound module, be 
sure to continue on to the next chapter after you 
finish this one. It contains important information 
about how to set up for MIDI playback and 
recording.

 

INSTALLING MOSAIC

 

Installing Mosaic is easy because the Mosaic disk 
has a program on it that does the installation 
automatically for you. To install Mosaic:

 

1

 

Disable all CDEV’s (Control Panel Devices) and 
Extensions, including virus protection utilities 
such as SAM, Virex, Vaccine, Disinfectant, or 
GateKeeper during the installation process.

These files can sometimes interfere with 
installation. To do so under System 7, restart or 
turn on your Macintosh with the shift key held 
down until you see the message, “Extensions Off ”, 
which appears right after “Welcome to Macintosh”. 
Doing so turns off all extensions until the 
computer is restarted. Under System 6, remove all 
non-Apple INIT’s and Control Panels from your 
System Folder and then Restart your Macintosh. It 
is especially important to do this right before you 
install Mosaic and authorize the hard disk. Once 
the program has been installed and authorized, 
you can reenable them.

 

2

 

Insert Disk 1 of the Mosaic installer disks and 
run the installer by double-clicking the icon called 
“Double-click to install”.

Just follow the directions that the installer gives 
you, and insert the appropriate disks when they are 
requested. When you finish, it may ask you to 
restart.

 

☛

 

If you have more than one hard disk, the 
installer only lets you install on hard disks that have 
a System Folder on them. If you want to install 
Mosaic on a disk that doesn’t, install on a hard disk 
that does and then copy the Mosaic folder to the 
desired disk afterwards.

 

What does the installer do?

 

The installer checks the computer to make sure it 
meets the hardware and software requirements 
necessary to run Mosaic. If so, the installer places 
Mosaic in a Folder on the hard disk, along with 
several additional files, such as a folder containing 
demo files. The installer also adds Mosaic fonts, 
system extensions, and other necessary files to your 
Macintosh System Folder. The following table 
provides a summary. The information in this table 
is subject to change with each update of Mosaic.

Double-click the installer, which does the 
entire installation automatically for you.
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WHAT NEXT?

 

The rest of this chapter tells you several things you 
should know about authorizing and deauthorizing 
Mosaic. After you complete this chapter, what you 
do next depends on what you would like to do.

 

If you want to be able to record and play music on 
a MIDI instrument…

 

Turn to the next chapter to continue the 
installation process. You will use a program called 

 

FreeMIDI Setup

 

 to describe each of your MIDI 
devices to Mosaic so that Mosaic can successfully 
record and playback from them.

 

If you won’t be using MIDI playback and 
recording…

 

You are finished with installation. Skip the next 
chapter and proceed to chapter 4, “About the 
Tutorials” for information about how to get started 
with Mosaic.

 

Mosaic-related item: What it is/does:

 

Mosaic™ The Mosaic application is placed in a 
Mosaic folder on your hard disk.

Mosaic demo files This folder contains demonstration 
files that you can open with the Open 
command in Mosaic’s File menu.

Mosaic templates This folder provides files with several 
common voice, staff, and page lay-
outs, from a lead sheet up to a full 
40-staff orchestra score.

Tutorial Folder This folder contains sample Mosaic 
music files necessary for the tutorials 
later in this guide.

Mosaic Screen 
Fonts

This font suitcase contains several 
screen fonts required by Mosaic, and 
they are placed in your System by the 
installer. The fonts are: Sonata and 
MosaicFont.

FretBoard Screen 
Fonts

This font suitcase contains the Fret-
Board font screen bitmaps, and they 
are placed in your System.

MosaiFon
FreBoa

These printer fonts are placed in the 
System Folder and provide high reso-
lution display and printing for the 
three music fonts that Mosaic uses 
(Sonata, MosaicFont, and FretBoard).

FreeMIDI This system extension is placed in 
your System Folder. It allows Mosaic 
to record and playback music from a 
MIDI device such as a keyboard or 
sound module. FreeMIDI also inte-
grates Mosaic with other FreeMIDI 
programs in various ways.

FreeMIDI Folder This folder is placed in your System 
Folder and contains files that are 
required by FreeMIDI.

FreeMIDI Applica-
tions Folder

This folder is placed on the top level of 
your hard disk. It contains several 
programs that help you configure Fre-
eMIDI and prepare Mosaic for MIDI 
recording and playback.

FreeMIDI Setup FreeMIDI Setup is a program found in 
the FreeMIDI Applications folder. It 
allows you to create a FreeMIDI Con-
figuration, which describes your 
MIDI studio to Mosaic and is required 
for MIDI recording and playback.

PatchList Manager PatchList Manager is a program found 
in the FreeMIDI Applications folder. 
It obtains the names of the sounds in 
your MIDI synthesizers so you can 
choose them by name from Mosaic.

Serial Switch If you have a Quadra 900, 950, or Mac-
intosh IIfx, this system extension is 
placed in the Control Panels folder by 
the installer to allow MIDI communi-
cation on the modem and printer 
ports. Without it, none of your MIDI 
software, including Mosaic, would 
work. Once it is installed, it must be 
set to “Compatible” mode.

Unicorn Power If you have a Macintosh PowerBook 
140, 145, 160, 165c, 170, 180, or 180c, 
this system extension is placed in the 
Control Panels folder by the installer 
to provide error-free MIDI communi-
cation on the modem and printer 
ports. Without it, you might have 
trouble using Mosaic, as well as other 
Mark of the Unicorn software.
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4 Preparing for MIDI Recording and 
Playback

Mosaic provides you with the ability to record, play 
back, and step-enter music via a MIDI keyboard or 
other instrument. You can:

■ Step-enter notes (one at a time) from your MIDI 
keyboard

■ Record music in real time by playing along with 
a metronome click

■ Split left- and right-hand keyboard parts onto 
two staves

■ Play back each voice (staff) on a separate MIDI 
instrument using a separate sound (as long as your 
MIDI hardware provides this capability)

INTRODUCING FREEMIDI
To provide you with these MIDI capabilities, 
Mosaic relies on FreeMIDI, a Macintosh system 
extension developed by Mark of the Unicorn. 
FreeMIDI provides many advantages for all Mark 
of the Unicorn MIDI software products. With 
regard to Mosaic, FreeMIDI provides you with:

■ A graphical representation of the MIDI devices 
in your studio

■ Patch lists, which make it easy for you to choose 
sounds by name from within Mosaic

This chapter takes you through the process of 
setting up FreeMIDI, which Mosaic requires for 
MIDI input and playback.

You can skip this entire chapter if…
If you do not plan to use Mosaic’s MIDI recording 
and playback capabilities, you can skip this entire 
chapter. You can also skip it if you already have 
another FreeMIDI-compatible program, such as 
Performer 5.0 (or higher), for which you have 

already created a FreeMIDI configuration and 
successfully achieved MIDI playback and 
recording.

SETUP OVERVIEW & QUICK-START GUIDE
Below is an overview of the process you will go 
through in this chapter. It is fairly simple and will 
probably take between fifteen and twenty minutes.

If you already have some experience with the 
Macintosh, MIDI, or Mark of the Unicorn 
software, and you are in a hurry, this overview 
should give you a pretty good idea of what you 
need to do to make the transition to FreeMIDI. A 
page number is included next to each step so you 
can get more detailed information about that step.

To install FreeMIDI:

1 Set up your MIDI gear. (page 12)

Make sure that your MIDI gear is connected and 
turned on, including your MIDI interface.

2 If you have Virtual Memory turned on in your 
Memory Control Panel, turn it off.

3 If you use OMS, decide if you want to use 
FreeMIDI instead, and, if so, install the OMS 
emulator.

FreeMIDI can emulate the Opcode MIDI System™ 
(OMS), allowing you to completely remove OMS 
from your system if you like. If you use software 
that requires OMS, you have two choices:

■ You can remove OMS (by dragging the OMS 
system extension out of the System Folder) and 
install the OMS emulator (by doing a Custom 
Install from the Mosaic installer disks).
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■  You can use both OMS and FreeMIDI indepen-
dently.

4 Run FreeMIDI Setup. (page 13)

This application is located in the FreeMIDI 
Applications folder.

5 Set the FreeMIDI System Preferences to tell 
FreeMIDI Setup which serial ports to search for 
MIDI interfaces. (page 11)

The preferences dialog should appear automati-
cally. If it doesn’t, choose FreeMIDI Preferences 
from the File menu.

6 In the Quick Setup dialog box, choose the 
method you will use to indicate which devices you 
have in your MIDI studio.

Click Continue to define each device one at a time 
(page 18) or, if possible, define them automatically 
using one of several shortcuts. Use the shortcut that 
best suits your situation:

1. Make FreeMIDI search your MIDI interface 
ports for all the devices in your studio automati-
cally. This only works for devices that are 
connected with both their MIDI IN and MIDI 
OUT. Click Auto Config in the Quick Setup dialog 
box. (page 16)

2. Open an existing Performer (version 4.2 or 
earlier), Digital Performer (version 1.4 or earlier), 
or OMS (version 1.2.1 or earlier) configuration file. 
The Performer configuration can be loaded from 
any source, either a regular Performer file or a 
separate configuration file. Click Cancel and 
choose Open from the File menu. (page 19)

7 Use the Save command in the File menu to save 
the FreeMIDI Configuration to any location on 
your hard disk.

8 Use the Check Connections command in the 
MIDI menu to make sure that FreeMIDI is 
successfully sending and receiving MIDI data to 
and from your MIDI devices. (page 23)

9 Quit FreeMIDI Setup.

You will now be ready to use any FreeMIDI-
compatible software. You do not need to keep 
FreeMIDI Setup open.

10 To set up patch lists, go to chapter 7, “Using 
PatchList Manager” (page 83).
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Serial cables

MIDI Interface
Serial cable

Modem 
port

MIDI Interface

Modem 
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Printer 
port

Figure 4-1: Connecting a MIDI interface to a Macintosh.

MIDI Interface
Serial cable

MIDI cables

IN

OUT

OUT
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Figure 4-2: Connecting a single MIDI device. Connect the device’s
MIDI OUT and MIDI IN ports to the MIDI interface as shown here.

MIDI Interface
Serial cable

OUT
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Figure 4-3: Connecting several devices to a simple 1-IN/1-OUT interface.  

IN
THRU

IN
THRU

IN
THRU

IN
OUT

MIDI Interface
Serial cable
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Figure 4-4: Connecting several devices to a simple 1-IN/3-OUT interface.  

IN

OUT
IN

IN

OUT

OUT

Controller

Figure 4-5: Connecting several MIDI devices to a
multi-port interface such as the MIDI Time Piece II. 

OUT
IN

Serial cable
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SETTING UP YOUR MIDI EQUIPMENT
Before you set up FreeMIDI, connect your MIDI 
hardware to the Macintosh. To so do, you will need:

■ Any standard MIDI/Macintosh interface

■ At least two MIDI cables

■ At least one MIDI device

1 Make sure the Macintosh is turned off.

2 Connect the MIDI interface to the Macintosh.

Refer to the owner’s 
manual of the 
interface for specific 
directions. Mosaic 
can send and receive MIDI information through 
both the modem and printer serial ports on the 
back of the Macintosh. If your interface connects to 
only one port, connect it to the modem port. 
Unless you have a large MIDI studio, you’ll want to 
connect a printer to the printer port so that you 
have quick access to printing. If you connect a 
MIDI interface to the printer port, you’ll have to 
always temporarily disable MIDI software settings 
in Mosaic before printing, which is inconvenient. If 
you have a MIDI Time Piece II or a MIDI Express 
interface, connect it to the modem port. If you have 
a large MIDI rig, you can connect two separate 
interfaces, one to each port, or a single interface 
that attaches to both.

3 Connect your MIDI device(s) to the interface as 
shown in one of the diagrams on page 11.

SETTING UP FREEMIDI
Once your MIDI hardware is connected to the 
computer, you are ready to begin setting up 
FreeMIDI.

Installing FreeMIDI
FreeMIDI is automatically installed in your System 
Folder when you install Mosaic as described in the 
previous chapter.

Turn off Virtual Memory
If you have Virtual Memory turned on in your 
Memory Control Panel, turn it off.

OMS compatibility
If you currently use the Opcode MIDI System 
(OMS) and it is required for OMS applications that 
are not yet FreeMIDI-compatible, you can use 
FreeMIDI to emulate OMS. Simply remove the 
OMS extension from your System Folder and 
install FreeMIDI’s OMS Emulater extension by 
doing a custom install from the Mosaic installer 
disks.

FreeMIDI Setup can read OMS configuration files 
created by OMS 1.2 and 1.21 and translate them 
into FreeMIDI configurations. Please read on for 
more information on this feature.

MIDI Manager compatibility
If you need to use applications that require MIDI 
Manager and do not yet support FreeMIDI, we 
recommend that you proceed now to Appendix B, 
“FreeMIDI and MIDI Manager” on page 105 of 
this guide for information on installing the 
FreeMIDI MM Driver for MIDI Manager. After 
installation the FreeMIDI MM Driver, please 
return to this page to continue your FreeMIDI 
configuration session.

What is a FreeMIDI configuration?
A FreeMIDI configuration is a file that you create 
and save on your hard disk using a program called 
FreeMIDI Setup. The file contains a graphical 
representation of the MIDI hardware devices in 
your studio, and it shares this list of devices with all 
FreeMIDI applications.

Here is an overview of the process we will go 
through in this chapter to create it:

1. Run FreeMIDI Setup.

Modem port iconPrinter port icon
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2. Set the FreeMIDI System Preferences to tell 
FreeMIDI Setup which serial ports to search for 
MIDI interfaces.

3. Create your FreeMIDI Configuration by 
defining each device one at a time or, if possible, by 
defining them automatically using one of several 
shortcuts.

4. Save the FreeMIDI Configuration to disk.

5. Use a feature called Check Connections to make 
sure that FreeMIDI is successfully sending and 
receiving MIDI data to and from your MIDI 
devices.

Launching FreeMIDI Setup
Locate the FreeMIDI Setup program. During 
Mosaic installation, it is placed in the FreeMIDI 
Applications folder on the top level of your hard 
disk.

1 Double-click the FreeMIDI Setup application 
icon to launch the program.

After the initial splash screen, the Welcome to 
FreeMIDI dialog box appears:

2 Click Continue.

The FreeMIDI Preferences dialog box appears. The 
FreeMIDI Preferences dialog box is where you tell 
FreeMIDI how you want it to handle certain 
aspects of its operation. Each preference option is 
explained in the following sections.

Figure 4-6: FreeMIDI Preferences Dialog Box.

Software Compatibility
If you wish to use MIDI applications that do not 
support FreeMIDI at the same time as FreeMIDI-
compatible applications, click Allow other 
applications. This allows non-FreeMIDI 
applications to have access to the Macintosh serial 
ports while FreeMIDI applications are running. 
The trade-off is that when this option is chosen, 
FreeMIDI-compatible applications cannot play 
MIDI in the background.

If you will only be using FreeMIDI-compatible 
MIDI applications, click FreeMIDI applications 
only. This allows FreeMIDI applications to play 
MIDI in the background.

Some FAX/modem and networking software can 
cause conflicts with other software, such as 
FreeMIDI, that needs to use the serial ports. If you 
have FAX/modem software and it needs to be 
active while you are working with FreeMIDI 
applications, you may need to choose the Allow 
other applications. Even this may not work. If it 
continues to cause conflicts, you may need to 
disable such software while using FreeMIDI. It may 
take some experimentation to find out what 
settings work best.
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MIDI Configuration
Click the check box for each serial port (modem 
and printer) to which you have a MIDI interface 
connected. Be sure that you connect and power up 
all the MIDI interfaces that you will be using, 
because FreeMIDI has the ability to automatically 
find most of your MIDI gear. 

Inter-application MIDI Communication
If you wish to be able to send MIDI data between 
FreeMIDI-compatible applications, click the Inter-
application MIDI check box. This option uses up 
some Central Processing Unit (CPU) overhead, so 
leave this option turned off unless you know you 
will be using it. You can always enable it a later time.

Extras
If you wish to have any patch changes that are sent 
by FreeMIDI updated in real-time for all your 
FreeMIDI applications, click the Monitor Patch 
Changes check box. For example, if you choose to 
monitor patch changes, the patch column in 
Mosaic’s Tracks window will always correctly 
display the last patch change sent to each device. 
This option uses up some Central Processing Unit 
(CPU) overhead, so if you find your Mac is 
working too slowly when using FreeMIDI 
applications, try leaving this option turned off.

3 Once you have reviewed the options above, set 
the FreeMIDI Preferences the way that you want.

4 Before you click OK, check to be sure that your 
MIDI interfaces are connected and powered-up.

5 Click OK to confirm your preference settings. 

When you click OK, FreeMIDI Setup scans the 
serial port(s) that you have selected for MIDI 
interfaces. At the time of this writing, FreeMIDI 
can recognize an MTP, MTP II and MIDI Express. 
When drivers are written to support other 
interfaces, FreeMIDI will be able to recognize these 
interfaces as well.

6 If you selected the printer port option under 
MIDI Configuration, and AppleTalk is enabled on 
the printer port, a warning alert box appears to ask 
if you would like to claim the printer port for MIDI.

If you are using AppleTalk for network communi-
cations or an AppleTalk printer, you should click 
Leave it alone and re-think your MIDI studio setup. 
Otherwise, click Claim the port and FreeMIDI will 
be able to use the printer port for MIDI. If you do 
so, remember to disable AppleTalk in the Chooser 
when you are through configuring FreeMIDI in 
order to avoid seeing this warning alert again. If 
you are using AppleTalk for an Ethernet network 
and your Ethernet connection is made via NuBus 
or SCSI or some other bus that does not utilize the 
printer port, FreeMIDI should not ask about 
disabling AppleTalk and network communications 
should not be interrupted.

7 If there are interfaces in your setup that are not 
powered on or connected properly, FreeMIDI 
Setup will not be able to find them.

If FreeMIDI cannot find any interfaces, the No 
Interface Found dialog will appear:
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Figure 4-7: No interface Found Dialog Box.

Check the connections and power switches and 
any MIDI/Thru switches on your interfaces and 
click Try Again. If your interfaces are not currently 
connected or not powered on, you can still create a 
FreeMIDI configuration at this time, but you will 
need to use the Choose Interfaces feature. For more 
information, see “Working with Off-Line 
Interfaces” on page 219 in the Mosaic Reference 
Manual. If FreeMIDI Setup cannot find some or all 
of your interfaces and you believe that they are 
connected properly and are powered on, proceed 
to Appendix C, “Troubleshooting FreeMIDI” on 
page page 109 of this guide.

Setting up your FreeMIDI configuration
After finding all the connected MIDI interfaces in 
your MIDI studio, the About Quick Setup dialog 
box appears:

Figure 4-8: About Quick Setup Dialog Box.

At this point, the step you take next depends on the 
method for configuring FreeMIDI that you wish to 
use. There are three methods for configuring your 
MIDI studio:

Configuring Your studio automatically
If you clicked Auto Config in the About Quick Setup 
dialog box, the Auto Config dialog box appears:

Figure 4-9: Auto Config Dialog Box.

How Auto Config works
Auto Config scans your MIDI interface(s) and tries 
to detect each MIDI device automatically. (For 
those of you who know a little bit about MIDI, this 
is accomplished with system exclusive messages 
that are unique to each instrument.) Auto Config 

Configuration 
method:

Explanation: What you should do:

Automatic 
configura-
tion

FreeMIDI auto-
matically scans 
the MIDI devices 
connected to 
your interface 
and includes 
them in your Fre-
eMIDI configu-
ration file.

Click the Auto 
Config button 
and proceed to 
“Configuring 
Your studio auto-
matically” on 
page 15.

Manual Con-
figuration

You indicate each 
MIDI device that 
you have from a 
pop-up menu 
and make a few 
settings for each 
device.

Click the Con-
tinue button and 
proceed to “Add-
ing devices man-
ually with Quick 
Setup” on page 18 
in this chapter.

Translating 
an existing 
configura-
tion file

You open an 
existing configu-
ration file from 
Performer, Digi-
tal Performer, or 
OMS, and your 
FreeMIDI config-
uration is set up 
to match it as 
closely as possi-
ble.

Click Cancel and 
proceed to 
“Translating Per-
former, Digital 
Performer, or 
OMS files” on 
page 19 in this 
chapter. This 
method can save 
you time if you 
have such an 
existing file and 
you have a large 
MIDI studio.
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can detect most MIDI keyboards, sound modules, 
and similar devices, although it can’t detect every 
MIDI device ever created. As a result, it will find 
most––and hopefully all––of your devices, 
depending on which ones you have. Later, you can 
add the ones it misses.

As you can see, FreeMIDI needs to be able to send 
MIDI data to the device, and it needs to be able to 
receive data back. As a result, before you proceed, 
be sure that all your MIDI gear is turned on and 
connected to your MIDI interface(s) properly. For 
Auto Config to find your MIDI devices, they need 
to have both their MIDI inputs and outputs 
connected to your interfaces. If you know how to 
do so, enable system exclusive transmit and receive 
on any MIDI devices that have such a setting. If you 
do not know how to do this, don’t worry. Many 
devices do not even have a setting for this function, 
and you can configure them manually instead.

☛ If you have a MIDI device that echoes 
(merges) incoming MIDI data to its MIDI out, this 
may cause errors during the Auto Config process. 
For best results, we recommend disabling this 
feature. Unfortunately, in some MIDI devices, 
echoing cannot be disabled. If this is the case, we 
recommend powering off these units until Auto 
Config is complete. You can then power them back 
up and add them to your FreeMIDI configuration 
manually. Some examples of such devices are the 
Yamaha KX-88 and Roland SBX-80.

☛ Due to their MIDI implementation, some 
MIDI devices may display “MIDI Buffer Full”, 
“MIDI Overflow error” or “device ID number 
mismatch” error messages in their front-panel 
LCD during Auto config. This is due to the large 
number sysex messages that are sent to each device. 
Don’t worry. This is harmless. (Hopefully, more 
and more manufacturers will support the universal 
MIDI device inquiry message, which will prevent 
messages like these.)

☛ Some MIDI devices may be found more than 
once because they are able to respond to more than 
once device ID at a time. If possible, try to set these 
devices to a single ID before using Auto Config.

Deciding whether or not to customize before 
you begin
As you can imagine, it takes time for Auto Config to 
scan for each of the hundreds of possible MIDI 
instruments that FreeMIDI knows about. Auto 
Config will take several minutes––more if you have 
one or more multiport interfaces with lots of MIDI 
ports on them.

If you want, you can customize Auto Config to 
search only for the instruments you have in your 
studio. This makes the whole process much faster. 
If you are not sure which MIDI devices are in your 
studio, or if you do not wish to spend time 
customizing Auto Config, click Begin and 
FreeMIDI will start searching your studio for MIDI 
devices. If you do know what devices you have in 
your studio, proceed now to “Customizing Auto 
Config” on page 17.

Using Auto Config without customizing
After you click Begin, FreeMIDI checks every cable 
on all of your MIDI interfaces for all the MIDI 
devices about which it knows. The piano keyboard 
progress bar gradually fills up as FreeMIDI 
searches your studio for MIDI devices as shown 
below.
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Figure 4-10: Auto Config Progress Window.

As FreeMIDI finds MIDI devices, it lists them in 
the status box below the piano keyboard. If you 
have the FreeMIDI Applications only option set in 
the FreeMIDI preferences, you can even switch out 
of FreeMIDI Setup to another application and 
FreeMIDI will continue searching your studio for 
MIDI devices while you do other work on your 
Macintosh! If you have the Allow other applications 
option set in the FreeMIDI preferences, you can 
still switch to another application during the Auto 
Config procedure, but FreeMIDI will stop 
searching for MIDI devices until you switch back 
into the FreeMIDI Setup application.

Click Stop if you want to interrupt the search 
process at any time and Auto Config will stop 
searching for MIDI devices. The Quick Setup 
dialog box opens and displays all the devices found 
up to that point.

This search can take several minutes depending on 
the number of MIDI devices and the type and 
number of MIDI interfaces in your studio.

Keep in mind that Auto Config may not be able to 
find all the MIDI devices in your studio. It is also 
possible that one MIDI device from a 
manufacturer could not be distinguished from 
another, closely-related MIDI device from the 
same manufacturer. An example of this is the Korg 

M1 family, which consists of the M1, M1R, M1EX, 
and M1REX. Auto Config will probably find all of 
these units and identify them all as Korg M1’s. To 
fine-tune and finalize your configuration, proceed 
to “Adding devices manually with Quick Setup” on 
page 18.

Customizing Auto Config
If you know which MIDI devices are in your studio, 
click Customize so that you can tell FreeMIDI for 
which devices to search. This can greatly decrease 
the amount of time it takes for Auto Config to find 
your MIDI devices. After clicking Customize..., the 
Customize dialog box appears:

Figure 4-11: Auto Config Customize Dialog Box.

If you do not want to continue with Auto Config at 
this time, click Cancel and an empty FreeMIDI 
Configuration window appears. Choose Quit from 
the File menu to exit FreeMIDI Setup. 

If you change your mind and no longer want to 
customize Auto Config, but you still want 
FreeMIDI to search for MIDI devices and 
configure your studio automatically, click EZ 
Option to return to the Auto Config dialog box and 
proceed to “Using Auto Config without 
customizing” on page 16.

Otherwise, begin customizing Auto Config as 
follows:

1 Select a device or devices from the list on the left 
and click Add.

piano keyboard progress bar
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To select more than one device, command-click 
each device that you wish to add. Shift-drag to 
select multiple devices that are together in the list. 
To select all the devices from the list at once, click 
Add All.

2 If you accidentally add a device or some devices 
for which you do not want FreeMIDI to search, 
select the device or devices from the list on the 
right and click Remove.

3 Keep adding devices until you have told 
FreeMIDI about all the devices in your studio that 
are in the list.

4 When you are done, click Begin.

FreeMIDI proceeds to check every cable of all of 
your MIDI interfaces for all the MIDI devices you 
have defined. You’ll see the progress dialog box 
shown Figure 4-10 on page 17.

The piano keyboard progress bar as shown in 
Figure 4-10 gradually fills up as FreeMIDI searches 
your studio for MIDI devices. As FreeMIDI finds 
MIDI devices, it lists them in the status box below 
the piano keyboard. If you have the FreeMIDI 
Applications only option set in the FreeMIDI 
preferences, you can even switch out of FreeMIDI 
Setup to another application and FreeMIDI will 
continue searching your studio for MIDI devices 
while you do other work on your Macintosh! If you 
have the Allow other applications option set in the 
FreeMIDI preferences, you can still switch to 
another application during the Auto Config 
procedure, but FreeMIDI will stop searching for 
MIDI devices until you switch back into the 
FreeMIDI Setup application.

Click Stop if you want to interrupt the search 
process at any time and Auto Config will stop 
searching for MIDI devices. The Quick Setup 
dialog box opens and displays all the devices found 
up to that point.

Keep in mind that Auto Config may not be able to 
find all the MIDI devices in your studio. It is also 
possible that one MIDI device from a 
manufacturer could not be distinguished from 
another, closely-related MIDI device from the 
same manufacturer. An example of this is the Korg 
M1 family, which consists of the M1, M1R, M1EX, 
and M1REX. Auto Config will probably find all of 
these units and identify them all as Korg M1’s. To 
fine-tune and finalize your configuration, proceed 
to the next section, “Adding devices manually with 
Quick Setup”.

Adding devices manually with Quick Setup
At this point, you have completed one of the 
following:

■ You have just completed the Auto Config process 
(the search is 100% complete).

■ You have just translated a Performer, Digital 
Performer, or OMS file and have skipped to this 
step.

■ You have just clicked the Quick Setup button to 
configure your studio manually.

In any case, you now see the Quick Setup dialog 
box on-screen as shown below in Figure 4-12.

Figure 4-12: Quick Setup Dialog Box.

This dialog box contains a list of all the MIDI 
devices that were found by Auto Config or by the 
file translation process on the left side under the 
label Current Configuration. If you have not used 
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Auto Config and are configuring your studio 
manually, this list currently displays only the MIDI 
interfaces in your studio.

If all the MIDI devices in your studio already 
appear in the list, you are done! Click Done and the 
FreeMIDI Configuration window will appear 
containing all your MIDI devices and their 
connections.

If there are no devices listed, or the list is 
incomplete, you will now need to tell FreeMIDI 
about these devices manually.

To add devices in the Quick Setup dialog:

1 Select the correct manufacturer, model, studio 
location and cable (if applicable) from the pop-up 
menus on the right and then click Add Device. 

If the pop-up menus do not contain a description 
of a particular device, choose Other and click Add 
Device. The first generic device you add is given the 
name Device-1. You will learn how to re-name and 
re-define these devices later in this tutorial.

2 If you accidentally add a device to the list that 
you do not want to appear in your studio 
configuration, select its name from the list on the 
left and click Remove.

3 If Auto Config found devices that are not the 
exact model installed in your studio, such as a Korg 
M1 instead of a Korg M1R, you can easily edit these 
devices.

Select the device on the right and click Remove. 
Now choose a new model from the pop-up menu 
on the right and click add. A new device is added 
with the same manufacturer and studio location.

4 When you have added all the devices to the list 
that are in your studio, click Done.

The FreeMIDI Configuration window appears, 
displaying all of your MIDI devices and their 
connections.

Figure 4-13: FreeMIDI Configuration Window.

Translating Performer, Digital Performer, or 
OMS files
FreeMIDI Setup can open configuration files 
created by Performer 4.2, Digital Performer 1.4, or 
OMS Setup 1.2 or 1.21 and create a FreeMIDI 
configuration which closely matches this configu-
ration. This can save a considerable amount of 
setup time. When translating Performer and 
Digital Performer configurations, you can open 
either a regular Performer/Digital Performer file or 
the configuration file, which may be saved 
separately.

To translate any of these files:

1 Choose Open from the File menu. Alternately, 
you can type command-O on your Mac keyboard.

A standard Macintosh File Open dialog box opens.
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Figure 4-14: Macintosh File Open dialog box.

2 Select the Performer, Digital Performer, or OMS 
Setup file that you wish to translate and click Open.

Use the directory pop-up menu to navigate to the 
disk and folder that contains the configuration you 
wish to translate. See your Macintosh owner’s 
manual for more information on opening files and 
navigating to disks and folders.

The selected file is translated as closely as possible 
into a FreeMIDI configuration.

If, after the translation process, all of your MIDI 
devices now appear in the FreeMIDI Configuration 
window and are connected to the proper MIDI 
interface input and outputs, proceed to “Arranging 
the FreeMIDI Configuration window” on page 20 
in this chapter for the next steps in the 
configuration process.

You may find, however, that some devices are 
misnamed, missing, incorrectly duplicated, or 
improperly defined. If so, you will need to edit the 
configuration using Quick Setup:

1 Choose Quick Setup from the Configuration 
menu

The About Quick Setup dialog box appears.

2 Click Continue... 

The Quick Setup dialog box appears.

3 Proceed to “Adding devices manually with 
Quick Setup” on page 18.

Arranging the FreeMIDI Configuration window
You can arrange the FreeMIDI Configuration 
window any way you like. We suggest that you drag 
device icons so that they appear as they do in your 
studio. For instance, you can arrange all the 
modules, which are in a rack to the left of your Mac, 
to the left side of the window and all the modules, 
which are in a rack to the right of your Mac, to the 
right side of the window. You can drag the patch 
cords, which connect the devices to the interfaces, 
up or down so that you can view the connections 
clearly. You can drag MIDI ports in a multi-cable 
interface, such as the MTP, MTP II or MIDI 
Express, up or down to create more or less space 
between them. You can delete input or output 
cables, which are not part of your studio setup, by 
clicking the patch cord to select it and typing the 
backspace or delete key on your Mac keyboard. 
You can also make and break connections by just 
dragging the ends of the patch cords. You can use 
the different options in the Views menu to change 
the size of the icons and to view input and outputs 
separately or together.

Figure 4-15: Connecting a device to an interface output.

Drag from 
here to here.
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Figure 4-16: Arranging FreeMIDI devices and connections.

The Clean Up Window Command
You can use the Clean Up Window command in the 
Views menu to quickly arrange all the devices in 
the window into uniform columns.

Making MIDI thru connections
When more than one MIDI device shares a single 
output port from a MIDI interface, you need to 
connect the MIDI Thru port of the device to the 
input of the other device. This mirrors the physical 
connection that you should have between the 
devices.

Figure 4-17: MIDI Thru Connections.

Making multiple MIDI input connections
FreeMIDI Setup allows you to connect more than 
one MIDI output from a device to a single MIDI 
input on an interface. When you make such a 
connection, you are telling FreeMIDI that both 
devices’ MIDI outputs are connected to a single 
MIDI input on an interface. Without some type of 
MIDI merger, this type of connection is not 
possible.

Connecting devices to other devices
FreeMIDI Setup allows one connection per port 
(input output, or thru) on each device. You cannot 
connect devices to each other except from MIDI 
Thru to MIDI In of a separate device. If you would 
like to make such connections, use the Cable 
Routing (on MIDI Time Piece and MIDI Express 
interfaces) or similar features in your MIDI 
interface or MIDI patch bay/merger gear.

MidiLocate
MidiLocate is a unique feature designed to make 
adding devices to your FreeMIDI configuration 
easier. In this mode, FreeMIDI automatically 
determines the proper input cable to which a 
device is physically attached and then displays this 
connection in the FreeMIDI Configuration 
window.

MidiLocate is a checkable menu item. This means 
that its state (on or off) is toggled each time you 
choose it from the menu. When there is a check 
next to the MidiLocate menu item in the MIDI 
menu, MidiLocate is enabled.

Dragging a connection vertically

Dragging a device to change its position

Dragging a connection horizontally

Dragging a MIDI port to 
change its position
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To use MidiLocate:

1 Select a FreeMIDI device in the FreeMIDI 
Configuration window.

2 Check to be sure that MidiLocate menu item in 
the MIDI menu is enabled.

The MidiLocate command should have a check 
next to its name. If it does not, choose it to select it. 
You can also use the Mac keyboard shortcut to 
toggle the state of MidiLocate by typing command-
L.

3 Play some MIDI data from the MIDI device.

FreeMIDI will determine from where the MIDI 
data is coming and redraw the FreeMIDI 
Configuration window to indicate the appropriate 
connection. 

Here is an example of MidiLocate in action. Let’s 
say you have a Kurzweil K2000 that is connected to 
some MIDI input on your MTP II, but you are not 
sure which input:

1 Add a K2000 FreeMIDI device your 
configuration using Quick Setup or Create Device.

2 Enable MidiLocate. 

3 Select the K2000 device.

4 Play some notes on its keyboard or send some 
other MIDI data from it and the K2000 device 
automatically is connected to the correct MIDI 
input port on your MTP II in the FreeMIDI 
Configuration window.

Saving the FreeMIDI configuration
Once you have a FreeMIDI configuration, it is a 
good idea to save it to disk so that you will not have 
to configure FreeMIDI for your studio again.

To save your configuration:

1 Choose Save from the File menu. Alternately, 
you can type command-S on your Mac keyboard.

A standard Macintosh File Save dialog box opens.

Figure 4-18: Macintosh File Save dialog box.

2 Use the suggested name “FreeMIDI 
Configuration” or enter another name for your 
configuration, if you like, and click Save or click 
Cancel to cancel the operation.

Use the directory pop-up menu to navigate to a 
disk and folder in which you wish to save this 
configuration. 

☛ If you are using System 7, you can use the New 
Folder button to create a new folder in which to 
save this configuration and others that you might 
create in the future. See your Macintosh owner’s 
manual for more information on saving files and 
navigating to disk and folders.

The current FreeMIDI configuration
There is no need to make this configuration 
“current”. Whichever configuration is visible in the 
FreeMIDI Configuration window is the current 
configuration that all FreeMIDI applications will 
use. Whenever you launch FreeMIDI Setup to view 
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or edit your FreeMIDI configuration, the 
configuration document with which you were last 
working is opened automatically.

Testing for MIDI input and output
You are almost done setting up your FreeMIDI 
configuration. The last thing you need to do is test 
the MIDI connections between your MIDI devices 
and FreeMIDI. To test for MIDI input and output:

1 Choose Check Connections from the MIDI 
menu.

This command puts FreeMIDI Setup in a special 
studio testing mode which allows you to easily test 
MIDI inputs and outputs. When the menu item is 
checked, Check Connections mode is enabled and 
the mouse cursor will change to the Check 
Connections cursor as shown in Figure 4-19 below.

Figure 4-19: Check Connections mouse cursor.

2 Check MIDI input by playing notes on your 
MIDI controllers or sending other MIDI data such 
as patch changes, controller data or system 
exclusive data from your other MIDI modules.

When FreeMIDI is receiving MIDI correctly in 
Check Connections mode, the MIDI port to which 
the MIDI device sending the MIDI data is 
connected will flash the eighth note symbol as 
shown in Figure 4-20 below. If no activity is 
indicated, check to be sure that the MIDI device 
that is sending the data has its MIDI output 
connected to the proper MIDI input on your MIDI 
interface.

Figure 4-20: Incoming MIDI Data indicator.

3 Check MIDI output by clicking devices.

In Check Connections mode, FreeMIDI Setup 
generates a C major chord on the default play 
channel and sends it to the MIDI output to which 
the device you click is connected. If all is well, this 
device should play the C major chord. If the MIDI 
device does not play notes, check to be sure that the 
MIDI device has its MIDI input connected to a 
MIDI output on your MIDI interface.

You are now ready for MIDI recording and 
Playback
Now that you have a FreeMIDI configuration that 
can send MIDI data to and receive MIDI data from 
all the MIDI devices in your MIDI studio, you are 
ready to begin using the MIDI features in Mosaic.

All of your FreeMIDI configuration devices appear 
in Mosaic throughout the program in places where 
you choose MIDI devices for playback and 
recording.

Quitting FreeMIDI Setup
You can now quit FreeMIDI setup by choosing 
Quit from the File menu. You do not need keep 
FreeMIDI Setup open. The only time you need to 
open FreeMIDI Setup is when you would like to 
make changes to your FreeMIDI studio configu-
ration. Conversely, you can open FreeMIDI Setup 
at any time, even while you have other FreeMIDI-
compatible programs open.

Where to go next
You have now completed all the necessary 
preparations to use all of Mosaic’s powerful 
features. Where you go next depends on what you 
would like to do.

If you would like a general tutorial about 
Mosaic…
Turn to the next chapter to get started.
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If you would like to be able to choose sounds 
(patches) on your MIDI synthesizer by name in 
Mosaic…
Turn to chapter 7, “Using PatchList Manager” 
(page 83) of this guide. It discusses how to load lists 
of sounds into FreeMIDI.

If you would like to learn more about MIDI input 
and playback…
See chapter 34, “MIDI Recording and Playback” 
(page 199) in the Mosaic Reference Manual.

If you would like to learn more about 
FreeMIDI…
This chapter has told you the basic things you need 
to know about FreeMIDI to use MIDI input and 
playback in Mosaic. However, FreeMIDI provides 
much more. For example, you can create your own 
icons for your MIDI devices in the FreeMIDI 
configuration. As another example, you can 
connect Mosaic’s transport controls (play, stop, 
rewind) to another FreeMIDI application, like 
Performer, so that they play together. For more 
information, see the FreeMIDI chapters in the 
Mosaic Reference Manual.
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5 A Guided Tour of Mosaic

This chapter introduces you to Mosaic by taking 
you on a guided tour of a completed lead sheet 
document. You’ll get familiar with Mosaic’s symbol 
palettes, page layout features, and more. You’ll also 
learn how to navigate Mosaic’s windows, menus, 
and mini-menus.

Exiting the tutorial at any time
If, for some reason, you need to stop when you are 
in the middle of the tutorial, do the following to 
stop the tutorial and exit Mosaic:

1 Choose the Quit command from the file menu.

If the computer does not allow you to access the 
menu, a dialog box is probably open. Click Cancel, 
and then try choosing Quit again.

2 If Mosaic asks if you would like to save the 
changes you have made, click No.

This exits the program without saving anything 
permanently to disk. This is OK because the 
tutorial is just for practice, and you can recreate it 
again later, if you like.

Rest easy and have fun
Don’t worry about making mistakes during the 
tutorial. There is nothing you can do “wrong”. Nor 
is there anything you can do hurt the computer or 
the software. If you get stuck, you can always quit as 
described in the section above.

Your screen may not match the tutorial exactly
At times, you may encounter a situation where 
your screen does not exactly match the tutorial. 
Don’t panic. The tutorial tries to cover most of 
these scenarios. Usually, you’ll be able to either 
proceed anyway, or you can use the Windows and 
Palettes menus to get back on track.

Opening Mosaic
Let’s begin by opening Mosaic. To do so, double-
click the Mosaic program icon located in the 
Mosaic Folder on your hard disk. If you haven’t 
moved the Mosaic folder since completing 
installation, it is located on the top level of your 
hard disk. You can get to it by double-clicking the 
hard disk icon to open the hard disk window.

Figure 5-1: Double-click the Mosaic program icon in the Mosaic
folder window to open Mosaic.

After a moment, you’ll see the Mosaic symbol 
palettes appear, along with the Mosaic menu bar.

If your Macintosh is running under System 7, you’ll 
still be able to see the Mosaic folder window, and 
perhaps other windows on the screen in the 
background. If you’d like to temporarily hide the 
other windows to reduce clutter on the screen, 
choose Hide Others from the Application menu at 
the far right of the menu bar:

The Mosaic program icon
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Figure 5-2: Hiding all other windows. To access the Application menu
shown above, click the Mosaic icon at the far right of the menu bar.

By now, here’s what you should see. Don’t worry if 
the symbol palettes aren’t positioned exactly as 
they are shown below. Later, you’ll learn how to 
open, close, and position them any way you wish.

Figure 5-3: After you double-click the Mosaic program icon and
choose Hide Others from the Application menu, this is what you
should see. Note the Mosaic symbol palettes and the Mosaic menu
bar.

Working with the cursor
Depending on what you are doing, the arrow 
cursor will change shape to aid you with a 
particular task. For example, later on you may 
notice that the arrow cursor temporarily changes 
into a spinning clock while Mosaic takes time to 
accomplish something that you have asked it to do. 
The spinning clock gives you an indication that 
Mosaic is busy and that further actions with the 
mouse will be postponed temporarily while 
Mosaic finishes what it is doing. (By the way, on fast 
Macintosh computers, the time you wait for the 
clock cursor is much shorter.)

The arrow cursor can switch to other cursors as 
well, depending on what you are doing. Most of 
them are familiar Macintosh cursors. Here are 
some examples:

Figure 5-4: Some of the cursors you’ll see in Mosaic.

Getting back the arrow cursor
At this point in the tutorial, the cursor is the 
standard arrow. Most of the time, it should remain 
an arrow, unless we change it for a specific task in 
the tutorial (such as when we insert a musical 
symbol or some text).

If you accidentally switch the cursor to something 
other than the arrow, you can always get back the 
arrow right away. There are two ways to do so:

■ Press command-period

OR

■ Click the arrow icon in the Notes palette (The 
Notes Palette will be explained in just a moment.)

If Mosaic starts giving you unexpected results 
when you click, get back the arrow cursor and try 
again.

As you get to know Mosaic, you’ll use this 
technique all the time, without even thinking about 
it.

Getting familiar with palettes
Palettes are the floating panels filled with symbols 
that you see at the top and to the left of the screen. 
(See Figure 5-6 on page 28.)

☛ If you don’t see any palettes on your screen, 
don’t worry. You can open each palette by choosing 
its name from the Palettes menu.

Arrow
cursor

Text
cursor

Line break 
hand tool

General
symbol
entry
cursor

Staff
cursor
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Mosaic provides hundreds of musical symbols, 
which are grouped by musical meaning into eleven 
palettes to conserve screen space. You can close and 
open any palette at any time. You can arrange them 
on the screen in any way you wish, and Mosaic will 
remember their position, even after you close 
them.

For practice, choose Dynamics from the Palettes 
menu to open the Dynamics palette, and then try 
the techniques below. If your palettes are arranged 
differently than Figure 5-6 on page 28, use the 
techniques below to match Figure 5-6. This will 
make the tutorial easier to follow. When you are 
done, close the Dynamics palette. Leave open the 
Notes, Groupings, Text, and Barlines palettes. 

Figure 5-5: Working with palettes.

Opening the lead sheet example file
Now let’s open the lead sheet example file:

1 Choose Open from the File menu.

The standard Macintosh open dialog box appears.

2 Locate the Tutorial Folder and open it.

The Tutorial Folder is located in the Mosaic Folder. 
Most likely, it is already showing in the list on the 
screen. If not, use the Directory pop-up menu 
above the scrolling list and the Open button to the 
right of it to navigate to the Mosaic Folder.

3 Open the file called Lead Sheet Example by 
double-clicking its name or by clicking its name 
and then clicking the Open button.

To Close the palette, 
click its close triangle.

To open the 
palette, choose its 
name from the 
palettes menu. 
Notice that open 
palettes have a 
check mark.

To move the palette anywhere on 
the screen, drag it by its drag bar.

To swivel the palette horizontally or 
vertically, click its Swivel button.

To select a palette symbol for 
entry, click it. To deselect it, 
press command-period.
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☛ Notice that the arrow cursor turns into a 
spinning clock while the file is opening. This 
spinning clock cursor will appear whenever 
Mosaic takes a moment to complete a task.

4 You should now see a window on the screen 
containing music.

Figure 5-6: Opening the lead sheet example file.

Fitting the window to the size of your 
computer screen
If the window of music you now see on the screen 
fills the entire screen, you won’t need to do this 
step. If your computer screen is large enough to 
open the window wider and/or taller, click the 
Zoom box in the title bar. Mosaic will increase the 
size of the window so that it displays as much of the 
page as possible on your screen.

Figure 5-7: Clicking the zoom box to display as much music as possi-
ble. The zoom box is on the left side of the title bar of the window.

Zooming the display in and out
The window you are looking at is called a page view. 
It displays the music on a page exactly as it will 
print out. Mosaic allows you “zoom” the display out 
so you can see the entire page on your computer 
screen. You can also zoom in to focus on a 
particular area.

Mosaic provides 14 zoom levels, from 20% to 
800%. 100% represents actual size (the size on the 
screen matches the size at which the page will 
print). Let’s zoom in on the first measure:

1 Position the arrow cursor directly on top of the 
first measure in the top staff, but don’t click or 
press. Just position the arrow on top of the staff.

This tells Mosaic to center the first measure in the 
window as you zoom in.

2 Press command-left-bracket ( [ ).

The display gets 20% larger. command-left-bracket 
zooms in; command-right-bracket zooms out. A 
little later, you’ll see how to zoom more quickly.

Now, let’s really zoom in much further––five more 
levels. Here’s how to do it quickly:

1 Position the arrow cursor directly on top of the 
first measure again.

Like before, don’t click or press the mouse at this 
time. Just position the arrow on top of the measure.

2 Hold down the command key, and while 
holding it down, press the left-bracket key five 
times rapidly.

This causes Mosaic to jump directly to the last 
zoom level, without stopping at each one in-
between.

The Zoom box
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Figure 5-8: Zooming in 200% on the first measure.

Scrolling the display
If you don’t see the first measure as shown in 
Figure 5-8 above, you might need to scroll the 
display up, down, left or right. Use the window’s 
scroll arrows and scroll bars in the standard 
fashion.

Selecting a note
Click the first note in the measure. This selects the 
note.

Figure 5-9: Selecting a note.

☛ If the note does not become hollow as shown 
in Figure 5-9 on page 29 when you click it, and you 
see lines appear above and below the staff instead, 
the window has somehow been placed in Show 
layout mode (explained later). If so, just press 
command-L to switch out of Show Layout Mode, 
and then try clicking the note again.

The current voice box
Notice that when you select the note, the current 
voice box in the lower left-hand corner of the 
window to the left of the scroll bar displays what 
voice the note is in. In this example, the note is in a 

voice called Vocal. In Mosaic, a voice consists of an 
entire line of notes and/or rests, and it is displayed 
on a staff. Each staff contains at least once voice, 
and the notes on the staff reside within the voice. 
Staves can even display several voices at once. You’ll 
learn more about this later, so don’t worry if it 
seems a little confusing. The way that Mosaic 
handles voices and staves makes it very powerful 
and flexible.

The current voice box is also a pop-up menu that 
displays all of the voices in this piece of music. Press 
on the box to see the pop-up menu.

Figure 5-10: Using the current voice pop-up menu.

In this piece, there are three voices: Piano L/Bass, 
Piano R, and Vocal. The current voice box always 
tells you what voice you are working with. You’ll use 
it a lot in Mosaic.

Now click a note on the second staff (the treble staff 
of the piano part). Notice that the current voice box 
switches to the Piano R voice.

The current voice
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Dragging notes and other symbols
Mosaic lets you move musical symbols simply by 
dragging them. Let’s try it now.

1 Drag the first note in the top staff, the G, down a 
few lines.

Notice that the beam and slur follow the note. In 
general, Mosaic doesn’t treat musical symbols as 
mere graphic symbols. It treats them with musical 
meaning. You save time because Mosaic makes 
things look musically correct for you.

2 Now drag the second note in the measure to the 
right.

Notes can be dragged up and down to change their 
pitch, and left and right to adjust their spacing.

3 Now click directly on the slur above the 
sixteenth notes to select it.

Because the slur is so thin, you may need to try to 
click it more than once. You’ll know when you’ve 
successfully selected it because four handles appear 
as shown below.

Figure 5-11: Selecting a slur.

4 Reshape the slur by dragging it upwards from 
the middle.

Figure 5-12: Reshaping a slur.

5 Click the slur again to select a second time, and 
then reshape it some more by dragging one of the 
two handle above it.

Figure 5-13: Adjusting a slur by dragging one of its handles.

6 Now drag the beam of the second group of 
sixteenth notes upwards.

Just grab the beam and drag upwards.

Figure 5-14: Adjusting the height of a beam.

7 Adjust the angle of the beam by dragging the left 
handle as shown.
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Figure 5-15: Adjusting the angle of a beam.

Peace of mind with unlimited Undo & Redo
Now it’s time to learn about one of Mosaic’s most 
powerful and unique features: unlimited Undo. 
Mosaic, just like most Macintosh programs, allows 
you to undo––take back––the last action you 
made.

The last thing we did was to adjust the beam angle. 
But it doesn’t look very good, so let’s undo it. 
Choose Undo Adjust Beam from the Edit menu in 
the menu bar at the top of the screen as shown in 
Figure 5-16 on page 31.

Notice that the beam snaps back to its original 
position.

Figure 5-16: Using the Undo command.

You don’t have to stop after undoing just once, 
however. Mosaic remembers everything you do 
from the time you first open a file (last saved the 
file)! Let’s now undo all the changes we’ve made. 
Here’s a shortcut for using the Undo command:

1 Press command-Z.

This is the standard Macintosh command key 
shortcut for the Undo command. Just about every 
program that has an Undo command uses 
command-Z.

2 Keep pressing command-Z until measure one is 
back to its original state.

Don’t worry about undoing too many times. If 
there is nothing left to Undo, the menu command 
becomes greyed out and pressing command-Z 
does nothing. If you are not sure whether you have 
undone everything, check the menu. If the 
command is grey, you are done.

As if Undo weren’t enough, you can once again 
change your mind and Redo everything. That’s 
right. We can restore all of the changes we made 
using the Redo command in the Edit menu.

The shortcut for Redo is command-R. Try pressing 
command-R several times in a row to redo the 
adjustments. Redo is unlimited, just like Undo. You 
can use these two commands to freely move 
backwards and forwards through any series of 
actions you take in Mosaic. Talk about flexibility! 
Feel free to play around with Undo and Redo 
commands as much as you like. They’re kind of 
fun, aren’t they?

Getting familiar with Mosaic’s mini-menus
Mosaic has another unique feature called the mini-
menu. It is a small menu located in the title bar of 
each window, and it provides commands that are 
specific to that window.

The mini-menu in the page view window has 
several commands, as well as a list of all the 
available zoom settings. Currently, we are zoomed 
in to 200%. Let’s zoom out to 60% so we can see the 
entire page. Choose 60% from the mini-menu as 
shown in Figure 5-17.
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Figure 5-17: Using the mini-menu to zoom out to 60%.

Using the zoom box to adjust the window
After you zoom out, the full page appears in the 
window, but it may be partially obscured. To 
quickly adjust the window to show as much of the 
page as possible, click the zoom box again. If you 
have a smaller computer screen, you can see more 
of the page by zooming out to 40% or even 20%, 
although it becomes more difficult to make fine 
adjustments at these levels.

Figure 5-18: Zooming the page view to 60%. If your computer screen
is large enough, you may be able to see the entire page. If not, the
bottom of the page may still be below the edge of the window.

Using Show Layout mode to adjust the page 
layout
Mosaic’s page layout features give you complete 
control over the placement, spacing, size, 
indentation, and arrangement of the staves on the 
page. Best of all, you can make changes directly on 
the page.

To make adjustments to the page layout, we need to 
activate Show Layout mode in the view’s mini-
menu. To do so, select Show Layout from the mini-
menu. The command in the menu changes to Hide 
Layout, and margins appear on the page, along 
with staff names and the layout-related icons 
shown below.

Figure 5-19: Show Layout mode provides page layout features such
as draggable margins.

Mini-menu

Draggable margins appear 
in Show Layout mode.

These handles adjust the 
position of the lyrics.

In show Layout Mode, staff names 
are displayed on top of each staff.

These “pins” are 
manual line breaks.
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☛ Notes and other symbols can’t be edited in 
Show Layout mode.

Adjusting the page margins
To adjust the page margins, drag them. Try 
dragging the left and right margins towards the 
middle of the page to increase them a little bit.

1 Drag the left margin about a quarter of an inch 
to the right.

Notice that the left edge of each staff moves with 
the margin, and all the music adjusts automatically 
to the new margin.

2 Drag the right margin about the same distance 
to the left.

Increasing the spacing between the staves
Let’s increase the spacing between the staves on the 
page. First, we need to make some room at the top 
of the page by deleting the title and other text there.

1 Click anywhere on the text, “What Else Can I 
Do” to select the text box.

When the text box is selected, four handles appear 
around it.

Figure 5-20: Deleting the title and other text..

2 Press the delete key to remove the text.

3 Do the same for the text, “Words and music…” 
on the right side and the tempo markings on the 
left.

Now the top of the page is blank.

4 Drag the top staff to the top of the page.

To do so, press anywhere on the staff and drag 
upwards. When you are done, the staff will be all by 
itself at the top of the page. Notice that the top staff 
also has a box around it, which indicates that it is 
selected.

Figure 5-21: Dragging a staff.

Restoring even staff spacing
What do we do about the gap below the top staff? 
Fortunately, Mosaic can automatically restore even 
staff spacing after you adjust the location of the 
staves.

To restore even staff spacing:

1 Choose Select All from the Edit menu in the 
menu bar at the top of screen.

All of the staves become selected.

2 Choose Realign from the Format menu.

The staves become evenly spaced. (The same thing 
can be accomplished by selecting only the top staff 
and bottom staff using the Macintosh standard 
method of option-clicking.)
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Indenting the first staff system
You’ll learn a lot more about page layout later on. 
For now, let’s leave Show Layout mode and indent 
the first staff system.

1 Press command-L.

Pressing command-L is a shortcut for toggling the 
Show/Hide Layout command in the mini-menu. 
After doing so, the margins, staff names, line break 
pins, and lyric handles disappear to indicate that 
Layout Mode is no longer in effect.

2 Grab the barline that constitutes the left edge of 
the first staff system and drag it to the right about a 
half an inch.

Figure 5-22: Indenting the top staff system.

3 Grab the word “Vocals” and drag it next to the 
vocal staff.

If necessary, you can zoom in to fine-tune the 
position of the text with respect to the staff.

4 Grab the word “Piano” and drag it next to the 
piano staff.

The top staff system should now appear as shown 
below.

Summary
So far, you’ve already become familiar with the 
following important, “bread-and-butter” features 
in Mosaic:

■ The cursor

■ The symbol palettes

■ The Page View window

■ The Current voice box

■ Zooming in and out

■ Unlimited Undo/Redo

■ Mini-menus
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■ Show Layout mode

■ Adjusting margins and staff spacing

Understanding voices, staves, and views
Before you begin to build your own lead sheet, let’s 
take a look at the Voices window, Staves window, 
and Views window. These windows contain the 
building blocks––the underlying structure––of 
every Mosaic score. Looking at them now will help 
you understand how to create your own music. 
These windows provide a great deal of power and 
flexibility in the way you structure your scores.

1 Close the page view by clicking the close button 
at the far left of its title bar.

2 Choose Voices from the Windows menu.

The Voices window appears. It displays each voice 
that has been created for the score. In this case, 
there is a voice for the vocal part, the left- and 
right-hand piano, and a few percussion voices. 
These are the same voices that appeared in the 
current voice pop-up menu earlier. You can create 
as many voices as you like in a Mosaic score. Once 
you create them, you assign them to a staff in the 
Staves window.

Figure 5-23: The Voices window.

☛ In the example above, each voice is assigned to 
a Kurzweil K2000 MIDI synthesizer for MIDI 
playback. Obviously, the playback assignment you 
see may be different because you may have 
different MIDI devices. The same goes for the 
“Patch” column. These features are covered later in 
the tutorial.

3 Choose Staves from the Windows menu.

This example file contains four staves. So far, we’ve 
been working with the vocal staff and piano staves, 
which were displayed in the page view we worked 
in earlier. Notice that the Drum staff has two voices 
assigned to it. (If you don’t see any voices at all, 
choose Show Voices from the mini-menu.) Both 
voices appear on this staff. Later on, you’ll learn 
how to create voices and staves, and assign the 
voices to the staves.

Figure 5-24: The Staves window.

4 Choose Views from the Windows menu.

The Views window contains a list of all the views in 
the file. A view is a window that display staves. We 
were working in a page view for most of this 
tutorial. A page view can contain any sized page, 
and the page can contain any number of staves (as 
many as will fit) in any order. Later on, you’ll learn 
how to create views and place staves in them. In 
this example file, there are only two views: a page 
view and a galley view. As described earlier, a page 
view displays the music on a page exactly as it will 
print out. A galley view displays the staves in a 

Close button
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window that scrolls endlessly to the right. Galley 
views are useful for editing and for getting a bird’s 
eye view of the score. Galley views are great for 
entering notes, slurs, ties, dynamics, and other 
musical symbols. You can then display the music 
you’ve entered in a page view and touch it up, place 
text, set the desired note spacing and line breaks, 
and other final formatting tasks.

5 To take a quick peak at the galley view, double-
click the “infinity” icon to the left of its name in the 
list.

The Galley view window appears as shown in 
Figure 5-25 on page 36. It contains all four staves, 
including the drum staff.

You can create as many views as you want. Each 
view can display any combination of staves that you 
want. For example, you might have a “score” view 
that contains all staves. In addition, you might have 
a separate view for each staff by itself to serve as an 
individual instrument part.

You can even display the same staff in several views 
at once. For example, the staff might be in both a 
score view and an instrument part view at the same 
time. Changes to the staff made in one view will 
automatically be updated in the other. You’ll learn 
more about this later on.

Figure 5-25: The galley view.

Looking at the Lyrics window
Now let’s take a look at how the lyrics were typed 
in. Mosaic has a very intuitive method for entering 
lyrics.

1 Choose Lyrics from Windows menu.

The Lyrics window appears. It displays a list of all 
the lyrics in the file. A lyric is any body of text of any 
length that you would like to align with notes below 
a staff. In this file, there is only one lyric.

Figure 5-26: The Lyrics window.

2 Press on the word “Vocal” to observe the voice 
pop-up menu (but keep “Vocal” selected in the 
menu).

You can use this pop-up menu to assign the lyric to 
any voice in the piece. Mosaic then automatically 
displays the lyric text below the voice on its staff.
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Figure 5-27: The Voice assignment pop-up menu.

3 Let go of the pop-up menu, but keep “Vocal” as 
the selection when you do.

4 Double-click the lyric icon just to the left of the 
name “Lyric-1”.

The lyric text entry window appears. In this 
window, you type in lyrics, just like you would in 
any standard Macintosh text program. In fact, you 
can type the lyrics in your favorite word processing 
software (MacWrite, Word, WriteNow, etc.) and 
then paste the text into this window. Regardless of 
how you enter the text, Mosaic can then 
automatically line up each syllable and word with 
the notes in the voice, automatically skipping rests. 
All you really have to do is enter the lyrics and 
decide where the syllable breaks are. What a time 
saver! Syllables, by the way, are indicated with 
either a space or a dash. You can also change the 
text font, style, and size in this window.

Figure 5-28: The Lyric text entry window.

Printing the lead sheet example
Now let’s print the lead sheet example. Having a 
printed copy of it will be especially useful for the 
rest of the tutorial chapters. First, let’s restore the 
file to its original state so we can get an unmodified 
copy:

1 Choose Revert from the File menu.

A dialog box appears.

2 Click OK.

Mosaic discards all the changes we have made to 
the file and reopens the file from disk.

From here, you can print the page view in the same 
fashion as you would with any Macintosh program:

1 Open the Chooser from the Apple menu and 
select the desired printer.

2 Close the Chooser.

3 Back in Mosaic, make sure that the page view 
window is active.

The page view window is active when it is the front-
most window (not including the palettes). If it’s 
title bar is filled in, then it is the front-most 
window. If the title bar is blank, click it to make it 
active.

4 Choose Print from the File menu in Mosaic.

5 If necessary, make any adjustments to the Print 
dialog box options.
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The options you see depend on what type of 
printer you have and what version of the printer 
driver and System software your Macintosh is 
running.

6 Click Print.

Playing the lead sheet on a MIDI instrument
You can easily play the lead sheet score on a MIDI 
instrument if you have made the preparations for 
MIDI playback and recording as outlined in 
chapter 4, “Preparing for MIDI Recording and 
Playback”. If you haven’t, or if you are not planning 
to use Mosaic’s MIDI capabilities, skip this section 
and proceed to “Quitting Mosaic” on page 40.

To play the lead sheet:

1 Open the Voices window by choosing it from the 
Windows menu.

Each voice has a MIDI play-enable button, as well 
as a MIDI playback destination and patch. Notice 
that the vocal and piano voices are already play-
enabled (their button is black), and the drum 
voices are unplay-enabled (muted).

☛ The playback destination displayed on your 
screen is probably different than what is shown 
below in Figure 5-29 because you probably have 
different MIDI instruments than the ones used in 
this example.

Figure 5-29: Preparing for MIDI playback.

2 Leave the drum voices muted as shown above.

3 Choose the desired MIDI playback destination 
for the Vocal voice from the “Play/Ch” column pop-
up menu to the right.

To do so, press on the current assignment to open a 
pop-up menu. In Figure 5-29 above, you would 
press on the word “K2000-3” to the right of the 
Vocal voice. On your screen, press whatever name 
appears in that position. The resulting pop-up 
menu displays the MIDI device(s) in your studio, 
similar to what is shown below in Figure 5-30. Each 
device also has a sub-menu of MIDI channels 
available on the instrument. In this example, the 
Kurzweil K2000 channel 3 is being selected.

☛ If you only have one MIDI device, the pop-up 
menu will have only one device in it, so it may not 
look like the pop-up list shown in the example. 
Similarly, if a device has only one MIDI receive 
channel available, no sub-menu appears for that 
device.

Figure 5-30: Selecting a playback destination for each voice.

4 In a similar fashion, choose a playback 
destination for both piano staves.

You can assign the voices all to the same MIDI 
destination if you like. If you have several different 
MIDI devices, you can assign the voices to separate 
devices. Here’s a suggestion: assign the vocals to a 

Play-enable buttons Playback destination Patch
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MIDI source that has a good solo instrument 
sound, like trumpet or sax. Assign the piano voices 
to a synth that has a bright acoustic piano sound.

5 Choose a patch for each device by pressing its 
current patch assignment to open the pop-up 
patch list and select the desired sound.

For example, in Figure 5-29 on page 38, you would 
press on the word “Patch-19” to open the pop-up 
patch list.

On your screen, press whatever name appears in 
that position. The resulting pop-up menu displays 
a list of patches (the MIDI term for sound). If you 
have been using a FreeMIDI-compatible librarian 
program, such as PatchList Manager, at any time 
before doing this Mosaic tutorial, you might see a 
list of names similar to what is shown on the right 
in Figure 5-31. If not, you will see the list of generic 
names shown on the left.

Figure 5-31: Selecting a patch (sound) on your MIDI instrument. A
generic patch list is shown on the left, and the patch list for the
Kurzweil K2000R synth/sampler is on the right. Any FreeMIDI-
compatible patch librarian software can provide patch names as
shown on the right. Examples of such software are the PatchList
Manager program that is included free of charge with Mosaic, and
Unisyn, Mark of the Unicorn’s universal editor/librarian software.

If you are choosing sounds from the generic list on 
the left, you’ll have to check your synthesizer to 
determine what patch number to select in this pop-
up menu. For example, if your synth has a Grand 
Piano sound, and it’s number is 1, choose Patch 1 
from the pop-up menu.

☛ If you aren’t sure about the sounds in your 
synthesizer, don’t go crazy selecting a sound at this 
point in the tutorial. Just choose Patch-1 for now. 
On most synths, it is a fairly generic instrument, 
such as a piano or electric piano.

As you can see, it is much easier to choose sounds 
by name. If this is important to you, you’ll need to 
learn how to use PatchList Manager or some other 
FreeMIDI compatible librarian software. See 
chapter 7, “Using PatchList Manager” (page 83) on 
page 25 of this book after you complete the 
tutorials in this book.
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Using the transport controls
Now you are ready to begin playing:

1 Open Mosaic’s tape-deck style Transport 
controls by choosing Controls from the Windows 
menu.

The Transport controls appear. You’ll learn more 
about these controls in the MIDI chapter in the 
Reference Manual. For now, let’s just play back.

Figure 5-32: Mosaic’s transport controls for MIDI playback and
recording.

2 Click the play button.

If all goes well, you’ll hear your the music play back 
on your MIDI instrument for about 30 seconds. As 
it does the counter gives you a running update of 
the measures and beats as they are played.

If you need to stop playback for some reason before 
Mosaic reaches the end of the piece, just click the 
Stop button. Otherwise, Mosaic will stop when it 
reaches the end of the page.

To play it again, press Rewind and then Play.

If you don’t like the instruments being used, click 
stop and change the patch as described earlier.

If you hear bad notes, check the Voices window to 
make sure that the drum voices are muted as shown 
in Figure 5-29 on page 38.

If you don’t hear anything at all, make sure the 
synthesizer volume is turned up and check all of 
your MIDI and audio connections. (Is the volume 
up on your mixer?) If you still don’t hear anything, 
don’t worry. You’ll need to review chapter 4, 

“Preparing for MIDI Recording and Playback” in 
this book. You can do so when you finish this 
tutorial.

Quitting Mosaic
Congratulations! You are well on your way to 
mastering the art of notating music with Mosaic. 
To complete the tutorial, let’s quit Mosaic.

1 Choose Quit from the File menu.

A dialog box may appear asking you if you would 
like to save changes to the file.

2 If you see the above dialog box, click No.
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